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Evolution of genes: Ortholog vs Paralog
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A pipeline for phylogenetic analysis
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FASTA file

>NP_001014992 .2 inositol 1,4,5-triphosphate kinase [Apis mellifera]
MSRSINMDQEKKNNVENLKSGGSTTPASPTLSTPPTLNLMEQILLAKT EKQNLHESDDLHESDGRVGGKRRNIL LRRTDS
MDSQNSASTYNSF LSSDSASS GNVYCKCDDCLLGIVDDYQRNPSVVGRKKSSGWRK LRNIVHWTP FFQTYKKQRYPWVQL
AGHQGNFRAGPTPGTILKKLCPQEEACFRL LMNDILRPYVPEFKGVLDVKDVEEGNVEETNSEETHQKDGSSDSVIKRTV
VSSYLQLQDLLGD FEHPCVMDCKVGVRTYL ESELAKAKERPKLRKDMY EKMVQVDP TAPNAEERRVQGVTKPRYMVWRET
ISSTATLGFRVEGIKLAHGGS SKDFKTTRTREQVTEALRRFVEGYPHAVPKYIQRLKAIRATLKASPFFASHEVVGSSLL
FVHDTKNAGIWMIDFAKTLPLPQHLPRIHHDAEWKVGNHEDGYLIGVNNLIDIFQDIRNSEET

>NP_0081014993 .1 elongation factor 1-alpha [Apis mellifera]
MGKEKIHINIVVIGHVDSGKS TTTGHLIYKCGGIDKRTI EKFEKEAQEMGKGSFKY AWVLDKLKAERERGITIDIALWKF
ETSKYYVTIIDAPGHRDFIKNMITGTSQADCAVLIVAAGTGEFEAGISKNGQTREHALLAFTLGVKQLIVGYNKMDSTEP
PYSETRFEEIKKEVSSYIKKIGYNPAAVAFVPISGWHGDNMLEVSSKMPWFKGWTVERKEGKVEGKCLIEALDAILPPTR
PTDKALRLPLQDVYKIGGIGTVPVGRVETGVLKPGMWWTFAPAGLTTEVKSVEM

>NP_0081014994 .1 glycerol-3-phosphate dehydrogenase [Apis mellifera]
MAEKLRICIVGSGNWGSTIAKIIGINAANF SNFEDRVTMYVYEEIINGKKLTEIINETHENVKYL PGHKLPPNI IAIPDV
VEAAKDADILTFVVPHQFIKRICSALFGKIKPTAIGLSL IKGFDKKQGGGIELISHITSKQLHIPVSVLMGANLASEVAN
EMFCETTIGCKDKNMAPILKDLMETSYFKVVWVEDVDSVECCGALKNIVACGAGFIDGLGLGDNT KAAVMRLGLMEITIKF
VNIFFPGGKKTTFFESCGVADLIATCYGGRNRKICEAFVKTGKKISEL EKEMLNGQKLQGPFTAEEVNYMLKAKNMENRF
PLFTTVHRICIGETMPMELIENLRNHPEYIDETRNYQECKCST

>NP_001019868 .1 major royal jelly protein 9 precursor [Apis mellifera]
MSFNIWWLILYFSIVCQAKAHYSLRDFKANTIFQVKYQWKYFDYNFGSDEKRQAATQSGEYNYKNNVPIDVDRWNGKTFVT
ILRNDGVPSSLNVISNKIGNGGPLLEPYPNWSWAKNQNCSGITSVYRIAIDEWDRLWVLDNGISGETSVCPSQIVVFDLK
NSKLLKQVKIPHDIAINSTTGKRNVVTPIVQSFDYNNTWVYIADVEGYALITYNNADDSFQRLTSSTFVYDPRYTKYTIN
DESFSLODGILGMALSHKTQNLYYSAMSSHNLNYVNTKQFTQGKFQANDIQYQGASDILWTQASAKAISETGALFFGLVS
DTALGCWNENRPLKRRNIEIVAKNNDTLQF ISGIKIIKQISSNIYERQNNEYIWIVSNKYQKIANGDLNFNEVNFRILNA
PVNQLIRYTRCENPKTNFFSIFL

>NP_801027532.1 follistatin-like 5 [Apis mellifera]
MRCMLEIAARSFLLLSIASTYVVSVAGYKHSRRHRDFTVAESYDASSSNSDSLSMTIPPSIDRSS IHEESYLAESSRSID
PCASKYCGIGKECELSPNSTIAVCVCMRKCPRRHRPVCASNGKIYANHCELHRAACHSGSSLTKS RLMRCLHHDIENAHI
RRTLHMNRTSLKT SKIVSYPKSRSRKKGGLKDNLIPDKNDPDSKECSNQEYEIMKDNLLLYNHAR LMSQDNHSKEYLVSI
MFSHYDRNNNGNLEREELEQF AENEDLEEL CRGCNLGHMISYDDTDGDGKLNVNEF YMAFSKLYSVSVVSLDKS LEVNHI
SARVGDNVEIKCDVTGTPPPPLVWRRNGADLETLNEPEIRVFNDGSLY LTKVQLIHAGNYTCHAVRNQDVWVQTHVLTIHT
IPEVKVTPRFQAKRLKEEANIRCHVAGEPLPRVQWLKNDEALNHDQPDKYDLIGNGTKLIIKNVDYADTGAYMCQASSIG
GITRDISSLVWWQEQPTPTTESEERRFFSFHQWGILVYEPSACRPRHEIRSTDVIPGTQEHVCGVKGIPCSWGRAINVANR
IGGLQHPGAVWWF TVSLH

>NP_801032395.1 putative tyramine receptor [Apis mellifera]
MANQTANYYGDVYQWNHTVSSGERDTRTEYYLPNWTDLYLAGLFTMLIIVTIVGNT LVIAAVITTRRLRSVTNCFVSSLA
AADLLVGLAVMPPAVLLOLTGGTWELGPMLCDSWVSLDILLCTASILSLCAISIDRYLAVTQPLIYSRRRRSKRLAGLMI
VAVWVLAGAITSPPLLGCFPRATNRDIKKC SYNMDSSYVIFSAMGSFFLPMLVMLYVYGRISCVIASRHRNLEATESENV
RPRRNVLIERAKSIRARRTECVTNSVTCDRPSDEAEPSS TSKKSGIVRSHQQSCINRVARETKTAGTLAVVWGG FVACWL
PFFILYLATPFVPVEPPDILMPALTWLGWINSAINPFIYAFYSADFRLAFWRLTCRKCFKSRTNLDPSNRKLPAPANWKK
DTTRT

Cluster analysis
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K-means vs Hierarchical Clustering

Hierarchical K-means
Hierarchical Clustering Dendrogram
I L
N
0 (1 ] : ol
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Number of points in node (or index of point if no parenthesis).

* pre-specified K (humber of groups);
» prefer clusters of similar size



WGCNA transformation

Cluster Dendrogram
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MCL "“* j; b f%ﬁ :%% % ;_f':\-'*f’f‘- '**
. *‘:-:-. _.ﬂ-" e E S _,

- a cluster algorithm for graphs “1.," A % ‘é; %ﬂ X %y b %

* Single Parameter: -I (Inflation, range from 1.1 to 10.0)

* Increasing the value of -l will increase cluster granularity



MCL on BLAST results (https://micans.org/mcl/)

#cut the blast output to 3 columns: querlD, targetiD,

cut -f 1,2,11 blastOutfmt6.txt > seqg.abc

evalue
mcxload -abc seq.abc --stream-mirror --stream-neg-log10 -stream-tf 'ceil(200)" -o #transform evalues
seg.mci -write-tab seq.tab
mcl seg.mci -1 5.0 -use-tab seq.tab #irun mcl.

Output text file: each line is a cluster, with gene names in the same cluster separated by “tab”

Genel Gene234 Gene56
Gene3

Gened43 Genel2
Geneb53 Gene877



MMseqs2: an ultra fast protein/DNA
sequence clustering tools

Command:

mmseqs easy-linclust input.fasta clusterResult tmp

e easy-linclust is a tool in the package that scales
linearly with number of sequences;

e Fast speed due to pre-filtering through k-mer
matching



Sequence clustering alone cannot solve orthologous relationship

Gene duplication and speciation, which happens first?

Gene duplication before speciatig Gene duplication after speciation

@ Gene duplication
Species_ @
Species 1

[ GeneA _ Gene B

Ancestor peciation .@

GeneB

: Speciation
species . .> Ancesto{GeneA R *

\ Gene B Species 2

Species I

Orthologs



Reciprocal best BLAST hit

Species 1

Gene2
Gene3

GeneN

How to define orthologs?

Without direct proof, here are the commonly accepted practices:

Species 2
GeneA

GeneB
eneC

GeneN

Synteny

Species 1 genome

G;;el

g Species 2 genome

Not ortholog
of Gene 1

Inferred from phylogeny

_____________
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Software for identifying orthologous genes *

Orthofinder (MCL + reciprocal best blast hits + phylogeny)

Input: A set of fasta files, with each fasta file represents all proteins from a single
genome.

Output: Genesin orthologous groups. Genes duplicated after speciation would
be in the same group.

M Csca nX (synteny)

Input: BLAST (gene sequence similarity) and GFF (gene position on the genome)

Output: Collinear orthologs.



Phylogenetic analysis pipelines:

Concatenated
orthologous genes

Orthologous gene
identification

¥
MSA for each
ortholog group

Y
Build phylogenetic
tree using MSA

SNP based

SNP callingon a
reference genome

)

Build phylogenetic
tree from vcf file



Phylogeny



What is phylogeny?

* A phylogeny, also known as a tree, is an explanation of how things
evolved, their evolutionary relationships between “taxa” (entities
such as genes, populations, species, etc.)

* In this introduction, we focus on phylogeny reconstruction by

sequences 0s?
Y &
%5

VVi

0.05



Outline

* Elements in the phylogeny
* How to construct a phylogeny
* Phylogeny evaluation and illustration

* Hands on practice



Ricinus communis
I; ¥ Populus trichocarpa

- w
; ; Lotus japonicus
% % Medicago truncatula < E————
oo ¥ Glycine max ——
; % Cajanus cajan
Cucumis sativus . .
79 g Malus x domestica LEAFY Controls Floral Meristem Identity
- : . . .
%ﬁ s perses in Arabidopsis
o = ragaria vesca
g E Arabidopsis thaliana < E—
Arabidopsis lyrata
% Brassica rapa E——
Carica papaya
Theobroma cacao
Vitis vinifera ——
Solanum tuberosum
+_ {Sofanum lycopersicum
» - Sorghum bicolor
W Zea mays
. Brachypodium distachyon
Oryza sativa CE—
HMusa acuminata
Selaginella moellendorffii
Physcomitrella patens Weigel D, Alvarez J, Smyth D R, et al. LEAFY controls floral meristem

Chlamydomonas reinhardtii identity in Arabidopsis[J]. Cell, 1992, 69(5): 843-859.



Elements of a phylogeny tree

Gma

Ptr

Taxa / Terminal Node/ tips




Elements of a phylogeny tree

Gma

Ptr
Internal nodes

Ath

Bra

Osa

0.05



Two branches at any internal note can be flipped without
changing the phylogeny

Gma

Ptr

Pir

Gma

0.05

005



Elements of a phylogeny tree

Gma

Ptr

0.05



Elements of a phylogeny tree

Gma

Ptr

The root is a very important internal node
representing the most recent common
ancestor of all sequences in the
phylogeny.

0.05



Place a root on the tree

Past Time Present
—

052 Gma

\):;A
Br a

0 Ptr

Wi Root

005 0.05



two main approaches to place a root

* Qutgroup rooting

0.066

0.050

0.046

0.038

0,044

0.045

Wi

0.065

D.018 Mtr

0017 Ath

-

0.138

°|ﬂ°
Bra

Gma 7

0.381

Osa

Mid-point rooting

0.138

Osa

0.313

the root is positioned at the midpoint
between the two longest branches




1. distance data

How to construct a phylogeny

1 2
Lath N
2. Bra 0.027
3.Gma  0.2339 0.244
4. Wi 0.216 0.205
5. Osa 0.452 0.444
6. Mtr 0.227 0.227
7. Ptr 0.239 0.250

* UPGMA

Neighbor-joining

0.164
0.452
0.0683
0.139

4 5 6
0.399
0.134 0.475

0.154 0.475 0.116

2.discrete characters

Species/Abbrv & Gr

1. Ath
2.Bra
3.Gma
4. Mir
5. 0sa
6. Ptr
7. Wi

® % ® ® ® % % ® % % *

EvnNELEH I FREELLVEBERYE
BuMNSELEHI FRNELLVEERYE
DunNELS@ I FREBLLVEERYE
BunNELEE FREDLLVEERYE
DumAALABLFREDLLLEBERFE
EvMNELS@ FRWEDLLVEERYE
BunNELc@ FREBLLVEBERYE

Parsimony
Maximum Likelihood
Bayesian Methods



Distance method

Normal . . . GCTATACGCTAGG. .. Jukes--Cantor Model

Base pair substitution . . .GCTATTCGCTAGG. o %

G A G
Substitution refers to the replacement of one amino acid A|13a] «a Q
with another amino acid in a protein or the replacement of T 1-3a o
one nucleotide with another in DNA or RNA C 1-3a | a
G a |1-3a
Distance calculated based on a specific substitution
model (Jukes--Cantor Jukes-Cantor Model (JC69)
* 1969
Model, Kimura, BLOSUMG4, etc.) * Evolutionis described by a single parameter, alpha (@), the rate of substitution.
Distances from each sequence to all others are * Assumptions:

calculated and stored in a matrix . Substitu.tions among4nucleotide types ctclcurwith equal probability (rate matrix below)
* Nucleotides have equal frequency at equilibrium

Tree then calculated from the distance matrix using a

specific tree-building algorithm



Kimura’s 2--parameter model (K2P)

1004 1ot
NHz 0o N 9“'1 :IEDSIUD:S
N HN o 80
N | \> i
| - g
QN H> purines HgN/I\N H g ;g A T ¢ G
adenine - A Transitions G guanine 3 50 A|ta2s| B B a
‘( )-‘ ﬁ 401 T| B [1a28]| « B
30
L. 201 Transversions C B a 1-0-28 B
10-
0 G| a B B |1a2p
Transversions Transversions 0 H ‘a .5 20 -k
Time since divergence (Myr)
Y‘ ,_V * Modelstransition and transversion rates separately
'i"'HE C Transitions T O
- - * Two parameters
EN\,&O pyrimidines | N’I\\o « afortransitionrateand B fortransversion rate.‘
H H :
cytosine thymine * Assumption:

* Nucleotides have equal frequency at equilibrium



Substitution Models

Jukes-Cantor
(One substitution type, equal nucleotide frequencies)

Independent nucl. freq. Two substitution types
F81/TN82 Kimura 2-Parameter (K2P)
/
Two substitution types Indep. nucl. freq. Three substitution types
HKY851F84/ Kimura 3 subst. type (K3ST)
Three substitution types Six substitution types
Tamura-Nei (TrN) Symmetric (SYM)
Six substitution types Independent nucl. freq.
m) I .l General time-reversible (GTR)

(revised from NIH lecture )



Protein Substitution Matrices

PAM250: Based on phylogenies where all BLOSUMG62: Based on clusters of sequences with
sequences differ by no more than 15%. greater than 62% identical residues

PAM250 BLOSUM62

H E A G A W G H E E H E A G A W G H E E

p 0-1 1 0 1-5 0 0-1-1 P -2 -1-1-2-1-4-2 -2 -1 -1
A-1 0 2 1 2-6 1-1 0 0 A-2-1 4 0 4-3 0-2-1-1
W-3-7-6-7-617 -7 -3 -7 -7 W-2-3-3-2-311 -2 -2 -3 -3
H 6 1-1-2-1-3-2 6 1 1 H 8 0-2-2-2-2-2 8 0 O
E 1 4 0 0 O0-7 0 1 4 4 E 0 5-1-2-1-3-2 0 5 5
A-1 0 2 1 2-6 1-1 0 0 A-2-1 4 0 4-3 0-2-1-1
E 1 4 0 0 O0-7 0 1 4 4 E 0 5-1-2-1-3-2 0 5 5

BLOSUM62 and BLOSUMS50 target alignments with
20 — 30% identity



Take home message

1. Transition is more frequent than transversion.

2. Different substitution model lead to different
phylogeny



Neighbor-joining algorithm

« Species represented as Points. Transform distance matrix into a U matrix

b .

Qi) =M =-2)+d(L) - ) dGK) - ) dG.K)
k=1 k=1

a-"

* Distance Matrix. a|b|lc|d|e
- 50| -38 | -34 | -34
a b c d e _I
o | 5|0 |10|10]9| ¢ -38 -38 -40 | -40
c 9 10|00 8|7 d  -34|-34 | -40 -48
la|9[10]a[o]s
Nels Sz le e | —-34|-34 | -40 -48

Q, p=4%5 - (5+9+9+8) — (5+10+10+9) = -50



join a and b and repeat the calculation

x| B | =|d| = c, c,
| l i )
a -50 | -38|-34 | -34 4 Fs
bk\ -llil h i’
b -50 _-33 -34_-34 N n\“ / y ; ; )
I
c | -38 -38 —40 | -40 - L — Ul cmmr® =
! J ] 2 L=
d |-34 -34|-40 -48 it \\\ \
| - . " .
e |-34|-34|-40| -48 L 2 % e
B

Using the

u |/ ec|d| e
formulas ' ' ' '
mentioned in the P i | / | A | 5
previous slide ) I Il I
calculate the g |7 |8|0|3
distances and the elsl7l3!o0

new matrix.



Summary of Neighbor Joining

1. The first step is to build a distance matrix

2. Neighbor-joining is a recursive algorithm (step by step).
Each step is to cluster the closest branch with the
previous step.



Packages with NJ algorithm

 PAUP* — Phylogenetic Analysis Using Parsimony

and other methods

PHYLIP — a suite of phylogenetic programs

MEGA — An integrated phylogenetic analysis package

Clustal X, Clustal O, muscle output tree, MAFTT implemented.

TASSEL -- a Java platform designed for the optimized analysis of crop genomic

diversity. TASSEL takes the genotypes as input



ASSEL

[£] updater - TASSEL 5 - O x
Eienmmmfm-gmnsﬁssummmm Help
[ Data =] | 281 W117HT g
¢ [ Matrix #= Distance Matrix =
[} Matrixmdp_geno
[y matrixMatrix mdp,
¢ [ Sequence
— [} mdp_genotype > Merge Trees
¢ [ Tree F” Subset Tree
D Remove Tree Branch Lengths
[} Resutt
S Convert Tree Names
N Tree A Pedigree Relationship Matrix
4 Combined A and G Relationship Matrix
& MDS
;i PCA
Remove NaN From Distance Matrix
Subtract Distance Matrix 1-30
Add Distance Matrix
.......................................................................................................................... Taxa ldentity Recognition
|l 271 B75
I
l : 270 CI31A
| +547
a |+ 269 B57
| +548
I 1 268 ND246 a
§ 3§ =




rFYexe

Clustering Method [ Neighbor_Joining

Save Distance Matrix

Ok Cancel Defaults User Manual




Maximum likelihood Trees

Most widely used method when accurate trees are required

Complicated models must be maximized through a guided trial-and-error, “hill climbing”
algorithm.

Decide whether to accept the new value. (Tree) = Prob(Data[Tree) = [1Prob(Data®Tree)

1. }Set initial parameter values and tree. The Tree The Data
S1: AAG
2. Calculatelikelihood.
— S2 AAA
3. Propose new parametervalueortree. — 53 GGA
4. Calculatelikelihood. S4- AGA
5.
6.

Repeatsteps 3-5 until changes no longer improve likelihood.



Log likelihood of different topology

log L =-2659.18 [og L =-2663.94 log L =-2701.36
Human - Human Human
Chimpanzee _ Chimpanzee Chimpanzee
Gorilla Goriila e Gorilla
Orang-utan Orang-utan ‘Orang-utan
Gibbon Gibbon Gibbon

Fig. 6.19 Three different hypotheses of relationship among the hominoids and the
likelihoods that each tree has given rise to the observed data.



Packages with ML algorithm

 PAML — tree search only for small datasets

 PHYML — a suite of phylogenetic programs
* MEGA - An integrated phylogenetic analysis package

 RAXxML-ng — a fast, scalable and user- friendly tool for maximum likelihood phylogenetic
inference, specifically designed for large phylogenomic analyses

* |Q-Tree -- a fast and effective stochastic algorithm for estimating maximum- likelihood
phylogenies

» FastTree --Specifically designed for efficiently estimating large phylogenies in terms of
number of taxa (up to one million); restricted to a small number of substitution models

* SNPhylo: a pipeline to construct a phylogenetic tree from huge SNP data, Reduce SNP

redundancy by linkage disequilibrium

Kapli P, Yang Z, Telford M J. Phylogenetic tree building in the genomic
age[J]. Nature Reviews Genetics, 2020: 1-17



Bayesian phylogenetic

Calculating the posterior probability of the
evolutionary parameters

Pr (v, v, 8|Data) = W

where:

T = tree topology

v = branch lengths

O = substitution parameters



Packages with Bayesian Inference algorithm

* MrBayes --Bayesian inference of phylogenetic trees. cited 30,000 times
* PhyloBayes-- a Bayesian software package for phylogenetic
reconstruction and molecular dating

 P4--Python package for phylogenetic analyses



Model selection

Y it Analysis Results Tools Help About
Load DMa alignment €0

[ Main - PhyML-log 1

° J M d |T t L - = R jHodalteat Z.1.4
O e es Jog rnljepgeatards 0. parclba, G.L. Taboada, R. Doallo and D. FPosada,
(1) Department of Biochemdstry, Genetics and Immunology
Uniweralty of Vigo, 36310 Vigo, Spain.
{1} pepartment of Electronloe and syscems

e P rotTe st fo r p rote | n M S A S e-mail: ddarribacudc.cs, dposadauriga.ca o

Wed Sep 1L D3:46:5H EDOT 2013

Abadi S, Azouri D, Pupko T, et al. Model selection HAC 05 X L0.8.8, arehi xS 84y Bite: B, nmeorse: 4

jHodelTest 2.1.4

may not be a mandatory step for phylogeny ERAL pronrin comss vieh ABSOLUTELY MO MRmRMTY oo oo

Thig 1z free software, and you are welcome to redistribote it under cercaln

reconstruction[J]. Nature communications, 2019,

Motloe: This program DAy oontain errore. Pleise inspaot results carefully.

1004): 1-11. o T T I T

Citationt Darriba D, Taboada GL, Doallo R and Posada D, 20L12.
"jHodelTest rr:omore models, new heuristles and parallel compuelng” .
Hature Methods %8}, 772.

skipping model selection and using instead the most
parameter-rich model, GTR+I+G, leads to similar inferences

general time reversible (GTR, nst=6): variable base frequencies,
symmetrical substitution matrix

gamma distribution (G): gamma distributed rate variation among
sites

proportion of invariable sites (I): extent of static, unchanging
sites in a dataset

| Likeliheod scores not available Ho data file loaded |




Bootstrapping

Ysample 1 == Tree 1
/ Wsample 2 =+ Tree 2 Estimate of
. / the
lerg::d The Sample = ¥sample 3 =+ Tree3 variance of
L]

o . the true
l \ o ° phylogeny
Ysamplen == Treen
Tree

Estimate of the
true phylogeny

Build pseudoreplicates of unlimited data by
sampling with replacement from limited data



Bootstrapping

Species/Abbrv & Gr
1. Ath

2. Bra

3.Gma

4. Mir

5.0sa

6. Ptr

7. Wi

® | * x ®* * * x * & * *

EvvNSLEH FRNEELLVEERYE
DuuNSLSH FREELLVEERYE
BuvNSELS8 FREBLLVEERYE
DuvNSELE@! FREBLLVEERYS
BumAALABLFREDLLLEBERFE
EvuNSLS@ FREBLLVEERYE
BuvNSLc@ FREBLLVEERYE

0.05

Gma



Hands on practice

* Input format

Fasta format

=Ath
MDP-EGFTSGL-FEWNFTEALVQAP-PPVPPPFLQQ-——QPVTEQTAAFGMR—————— LGGLEGLFGPYGIRFYTARKTIARLGFTASTLVGMEDEELE
>Bra
MDP-EGFTSGL-FRWNPTEAMVQOPSPPVFPFPPFPQO--OPPATPOTARFGMR—————— LGGLEGLFGPYGVEFYTAAKTAELGFTASTLVGMKDEELE
>GEma

MDP-DAFTASL-FEWDPRTVLPPAPAPPPEPSLLEYAMAPPPVTTAFHPARTAAPRELGGLEELFQAYGIRYYTAAKTIAELGFTVSTLVDMKDEELL

>Mtr
MDP-DAFTASL-FEWDPRTVLP--TAPPLEPQLLDYAVTPSTAPSPYYPARL--PRELGGLEELFQAYGIRYYTAAKIAELGFTVSTLVDMEDDELL

>0sa

MDPNDAFSAAHFFERWD-LGPFPAPAPVPPPPPP——————— PPEFPPPANVFRE—————— LEELVAGYGVEMSTVARISELGFTASTLLAMTERELL
>Ptr

MDP-EAFTASL-FEWDTREAMV-—————— FPHFNRELLEMVPPPQOQPPARAAFAVRE-——FRELCGLEELFQAYGIRYYTAAKTAELGFTVNTLLDMEDEELL
>Vvi

MDP-DAFTASL-FEWDPRGA----VAPPNE--LLE-———-———-———————————— ALGGLEDLFQEYGVREYYTAAKTAELGFTVSTLLDMKDEELL



Phylip format

7 451
Ath

Bra

Gma

MDP-EGFTSG

MSLSHIFRWE
LSAAGDSGTH
GYWDAGQGKM
GGSGLGTERQ
IAKDRGEKCP
SNALRRAFKE
YVPTKLRQLC

MDP-EGFTSG

MSLSHIFRWE
LSAAGDSGTH
GYWDAGQAKM
GGGVLGIERQ
TAKDRGEKCP
SNALRRAFKE
YVPTKLRQLC
%

MDP -DAFTAS
RTAAPRELGG
NSLSQTFRWD
---STDT-TT

L-ERWNPTRA
LEGLFGPYGI
LLVGERYGIK
HALDALSQE -
KKQQQQRRRK
REHPFIVTEP
TKVTNQVFRY
RGENVGSWRQ
HLERNNAVAA

L-FRWNPTRA
LEGLFGPYGV
LLVGERYGVK
HALDALSQED
KKPQQ-RRRK
REHPFIVTEP
TKVTNQVFRY
RGENVGSWRQ
HLERSNAVAA

L-FKWDPRTV
LEELFQAYGI
LLVGERYGIK
MALDALSQE-

LVQAP-PPVP
REYTAAKTIAE
AAVRAERRRL
---GLSEEPV
KPMLTSVETD
GEVARGKKNG
AKKSGASYIN
ACYKPLVNIA
AAALVG-GIS

MVQQPSPPVP
REYTAAKIAE
AAVRAERRRL
DWTGLSEEPV
KOMVTSVETD
GEVARGKKNG
AKKSGASYIN
ACYKPLVNIA
ASALVGNGIS

LPPAPAPPPR
RYYTAAKIAE
AAVRAERRRY

PPLQQ---QP
LGFTASTLVG

QEEEEEESSR
QQQDQTDAAG
ED----VNEG
LDYLFHLYEQ
KPKMRHYVHC
CRHGWDIDAV
CTGSSTSGRG

PPPQQ--QPP
LGFTASTLVG
LEEEEEESSR
HQLEHTDAAG
DD- - - -MNEG
LDYLFHLYEQ
KPKMRHYVHC
CRHGWDIDAV

PSLLEYAMAP
LGFTVSTLVD
----EDDDIK

TAKDRGEKCP
SNELRRAFKE
YVPTKLRQLC

TEVTHQVFRY
RGENVGAWRQ
HAERMNSVSAS

GEVARGKKNG
AKKAGASYIN
ACYKPLVAIA

LDYLFHLYEQ
KPKMRHYVHC
ARQGWDIDATL

VTPQTAAFGM
MKDEELEEMM

NNGGGGS - - -
EDDDGMDNGN
CREFLLQVQT
YALHCLDEEA
FNAHPRLSIW
GCGGDDLRF*

ATPQTAAFGM
MKDEELEDMM

NNGGGG- - - -
DDDDDGNGGG
CREFLIQVQT
YALHCLDEEA
FNAHPRLSIW
--ASGGLGFN

PPVTTAFHPA
MKDEELDDMM
RENMNMSNMLL

CREFLMQVQA
YALHCLDEEV
FNAHPRLSTW
--GSAHLPF*

1st line: Number of sequences(space)Number of sites
2nd line: Sequence ID (10 characters max) Sequence



Nexus format

#FNEXUS
[ Title Phylogenetic Analysis]
begin taxa;
dimensions ntax=7;
taxlabels
Ath
Bra
Gma
Mtr
Osza
Ptr
Vvi
end;
begin characters;
dimensions nchar=451;
format missing=7? gap=- matchchar=. datatype=protein;
matrix

Ath
MDP-EGFTSGL-FRWNPTRALVQAP-PPVPPPLQQ---QPVTPQTAAFGMR—————— LGG
LEGLFGPYGIRFYTAAKIAELGFTASTLVGMKDEELEEMMNSLSHIFRWELLVGERYGIK
AAVRAERRRLQEEEEEESSRRR-———— HLLLSAAGDSGTHHALDALSQE-——--GLSEEPV
QQODOTDAAGNNGGGGS-——-GYWDAGQGKMKKQQQQORRRKKPMLT SVETDED-—--VNEG
EDDDGMDNGNGGSGLGTERQREHPF IVTEPGEVARGKKNGLDYLFHLYEQCREFLLQVQT
IAKDRGEKCPTKVTNQVFRYAKKSGASY INKPKMRHYVHCYALHCLDEEASNALRRAFKE
RGENVGSWRQACYKPLVNIACRHGWDIDAVFNAHPRLS INYVPTKLRQLCHLERNNAVAA
ARALVG-GISCTGSSTSGRGGCGGDDLRE*—

Bra

MDF-EGFTSGL-FRWNFTRAMVQQFSFPVPFPPQQO-—-QFPATPQTAAFGMR—————— LGG
LEGLFGPYGVRFYTARKIAELGFTASTLVGMKDEELEDMMNSLSHIFRWELLVGERYGVE
AAVEAERRRLLEEEEEESSRRR———— HLILSAAGDSGTHHALDALSQEDDWTGLSEEEV



Conversion tools

* https://www.ebi.ac.uk/Tools/sfc/

# EMBL-EBI  Services  Research  Training  Industy  Aboutus  Q EMBL-EBI Hinxton ~

Sequence Format Conversion

®: Feedback <%Share

Tools > Sequence Format Conversion

These tools read different biological sequence formats and can convert them to other formats.

Seqret (EMBOSS)
EMBOSS Seqret reads and reformats biosequences.

AL aunch Seqret

MView

Transform a Sequence Similarity Search result into a Multiple Sequence Alignment or reformat a Multiple Sequence Alignment using the MView program.

L aunch MView



Format conversion in MEGA

Importing a FASTA-formatted alignment
File > Convert to MEGA format
Navigate to FASTA file
Data Format > .fasta (FASTA format)

0.6 \ MEGA 6.06(6140220)

Elle fnalysis Help

= Open A File/Session ... Chrl+0 b F o E‘“n E"‘; 7 E +
Open a Recently Used File » Distance T Diversity T Phylogeny T User Tree T Ancestors T Selection T Rates 7 ks T Diagnose T

wes Convert File Format to MEGA. ..

|'_|

800 N M86: Select File and Format
ata file to convert:

Printer Setup...

Exit MEGR A+
Chusersiwalenbergk\My Documentsh Teaching\PhyloSeganCourse\F El
Data Format: | NOME |
F
An (CLUSTAL)
nexus  (PAUP, MacClade)
phylip  (PHYLIP)
.gcg (GCG format )
Sfasta (FASTA format)
oir (PIR formnat)
nborf - (MBRF format) v
® (= = z = e ® . £ | &

Firzt Time Uzer? Tutorial Examples Citation Report a Bug Upclates? MEGA Links Toolbar Preferences



RAXML replaced RAXML

Evolution of RAXML

vi.0 Vv3.0 v3.0.21
i . i % ExaML
1

v0.1 v0.8
) ' RAXML-NG
I
' 2.12
n v v8.0 , V82 % AL
‘ ? RAXML-Light
>
2003 2006 2013 2015 2017 2019 2020

Adapted from the Exelixis Lab



command line for raxml

* /programs/raxml-ng_v0.9.0/raxml-ng --all --msa leafy align.fas --
model JTT+G4+F --prefix leafy_all

* /programs/raxml-ng_v0.9.0/raxml-ng --all --msa prim.phy --model
GTR+G --prefix Al

* The best tree is saved in [prefix].raxml.bestTree
* The tree with bootstrap value is saved in [prefix].raxml.support



llustration of phylogeny

* iTOL — web-based tool
* Mega
* TreeView, FigTree

* R packages ape, ggtree,



human Ehuman human
/ chimp chimp chimp
mouse mouse mouse
rat {t rat

2
O‘@@ & —human ":'o% 5\5@
—Cchimp &
] I—mcusa
& %, rat : s

adial root not shown ctreutar

Figure 13 Alternative representations of the same topology. Red lines indicate the same branch in each
representation. Trees can be rotated on the page and still depict the same tree. NB: The trees are not drawn to the
same scale.
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